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Nyheter

Nyheter i version 5.4.0 foér programvaran Tl Connect™ CE
Avsluta ldget Exam instéllning pa anslutna CE riknemaskiner

Avsluta instéllningen for providge pa din CE-raknare genom att ansluta CE-réknare till
datorn och valja

o Atgirder > Avsluta Undersokning-lage pa anslutna CE raknemaskiner i TI Connect™
CE.

Kom ihdg: Anvand senaste CE Bundle pa education.ti.com/84ceupdate for att garantera
att din CE réknare har de senaste och bast lampade raknarfilerna for din TI-84 Plus CE.

For mer information om nya och uppdaterade funktioner, ga till
education.ti.com/84ceupdate.

Nyheter
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Introduktion till TI Connect™ CE-programvaran

Med TI Connect™ CE-programvaran kan du snabbt och latt utbyta information mellan
din grafraknare och din dator.

Stoder alla Tl grafraknare-8x familj med USB-port, vilket inkluderar:
e TI-84 Plus CE

e TI-84 Plus CE-T

e TI 84 Plus CSilver Edition

e TI-84 Plus

e TI-84PlusT

e TI-83 Premium CE Edition Python* & TI-83 Premium CE

e TI-83 Plus.fr

e TI-82 Advanced

*0Obs! TI-83 Premium CE Edition Python och TI1-83 Premium CE kommer bada att visas
som TI-83 Premium CE.

Anmarkning: Anvand Tl Connect 4.0 som stoéder raknare med endast en |/O-port:
e TI-83 Plus

e TI-89 Titanium

e Voyage 200

e TI-73 Explorer
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Anvanda Tl Connect™ CE Software

Tl Connect™ CE Software innehaller verktyg som du kan anvdnda for att utbyta
information mellan din rdknare och din dator.

File  Edit  View  Actions  Help

M oce [Om

CONNECTED CALCULATORS (1)

(5] @ T84 Plus CE

Press [8] to capture calculator screens

Tl Connect™ CE-programvaran har tre arbetsomraden:
e Screen Capture (Infanga skdarmbild): hdr kan du hantera infangade skarmbilder.
e Calculator Explorer (Raknarutforskare): har kan du hantera rdaknarens innehall.

e Program Editor (Programeditor): har kan du hantera Tl grundldggande program.

Anvénda Tl Connect™ CE Software 3



Omrdden i Tl Connect™ CE Software
_lo|x]

File  Edit  View  Actions  Help

B ce [

o} CONNECTED CALCULATORS (1)

[ % T84 Plus CE
|E 0553

@ Press [8] to capture calculator screens

(3] (4]

o Menyrad - Anvand dessa menyer for att hantera raknarfiler och skarmar for
att visa raknarinformation och for att fa hjalp.

File Edit WView Actions Help

9 Verktygsfilt - Anvand dessa ikoner for att hantera datorfiler och skarmar.

= ] [ 100%

@ Arbetsomradespanel - Anvand denna panel for att valja arbetsomraden (Screen
Capture (Infanga skdarmbild), Calculator Explorer (Raknarutforskare) och
Program Editor (Programeditor)).

=3
IE]

e Riknarlistpanel - Anvand denna lista for att visa alla anslutna rdaknare och
valja en raknare for visning.

CONNECTED CALCULATORS (1)

% T1-84 Plus CE
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Innehallspanel - Anvand denna panel for att visa och hantera raknarfiler och
skarmar i anslutna réknare.

File  Edit  View  Actions  Help

B 8 8§ 1 &

CONNECTED CALCULATORS (1)

[El % Ti-84 Plus CE

Anmirkning: Du kan utféra de flesta atgarder pa dessa menyer genom att dra
och slappa poster till din anslutna raknare eller dator.

Anvénda Tl Connect™ CE Software 5



Anvinda arbetsomradet Screen Capture (Infanga
skarmbild)

| arbetsomradet Screen Capture kan du hantera infangade skarmbilder.

& 11 Connect™ CE

File Edit View

*Capture 1 x
CONNECTED CALCULATORS (1)
(O]
(5] @ -84 Plus CE

*Capture 2 x

MORMAL FLOAT AUTO REAL RADIAN MP n

CHLCULATE!

5:intersect
6:dusdx
7:fOx)dx
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Delar av Screen (Infanga skérmbild) Arbetsyta

Menyrad - Anvand dessa menyer for att hantera filer och bilder, visa raknarinformation
och for att fa hjalp.

File Edit View Actions Help

Anmirkning: Du kan utfora de flesta atgarder pa dessa menyer genom att dra och
slappa poster fran Innehallspanelen.

Verktygsfilt - Klicka pa dessa ikoner for att spara, skicka, kopiera, ta bort och andra
storleken pa filer.

Spara en fil till datorn.

Skicka en fil till en raknare.

Kopiera en fil.

Ta bort en fil.

Lagg till och ta bort en ram runt alla skarmbilder.

Andra storlek pa alla skirmbilder.

Visa skarmbildens storlek.

N o Ko~ o o)

Innehallspanel - Visa skarmbilder i Innehallspanelen.

*Capture 1 X
NORMAL FLOAT AUTO REAL RADIAN MP 1]
| |

Infdnga och anvinda skéirmar

Fran arbetsomradet Screen Capture (Infanga skdrmbild) kan du infanga och visa
skarmar fran din réknare.

Anvidnda arbetsomrddet Screen Capture (InfGnga skdrmbild) 7



Innan du borjar
Anslut raknaren till datorn och se till att den visas i Raknarens lista Panelen.

Infanga skdrmbilder fran raknare

1. larbetsomradespanelen foér TI Connect™ CE Software, klicka pa arbetsomradet
Screen Capture (Infanga skarmbild).

2. Visa skarmen pa den raknare som du vill infanga.
3. Klicka pa @ intill 6nskad raknare i Calculator List Panel (Rdknarlistpanel).

e Om mer dn en raknare ar ansluten, klicka pa @ bredvid an CONNECTED
CALCULATORS (Anslutna raknare) for att infanga skdrmar fran alla raknare.

Spara riknarskdrmar som filer

Fran arbetsomradet Screen Capture (Infanga skarmbild) kan du spara infangade eller
befintliga bilder fran din raknare som en PNG-fil.

*Capture 1 X
NORMAL FLOAT AUTO REAL RADIAN HMP n

Anmdrkning: Asterisken i borjan av ett bildnamn indikerar att bilden inte har sparats.

Spara en befintlig skdarm

1. Klicka pa den infangade skdrmen i Innehallspanelen.

2. Klicka pa .

For att spara flera skdarmbilder

1. Klicka pa Edit > Select All (Redigera > Valj alla).

2. Klicka pa .

Andra namn p3 en skirmbild

1. Placera markoren i borjan av skairmnamnfaltet.
Exempel: Capture 1 (Skarmbild 1).

2. Dubbelklicka pa namnet for att vilja det.
3. Skrivin ett nytt namn pa datorfilen.
Spara en ny skarmbild som en PNG-fil

1. Klicka pa bilden.
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5.

Klicka pa .

Navigera till 6nskad plats dar bilden ska sparas.

Anvand standardfilnamnet eller skriv in ett nytt filnamn.

o
Klicka pa .

Skicka skdarmbilder till anslutna raknare

Funktionen "Screen Capture Only" erbjuder ett satt att ta en skarmbild av en graf pa de
hégupplosande rdaknarna, beskdra grafomradet och sedan bara konvertera grafomradet
till en Bakgrundsbild. Markera Graph Area Only for att skapa denna typ av
Bakgrundsbild.

1.

Infanga skarmbilden om du inte redan har gjort detta.

2. Klicka pa skarmbilden for att vdlja den.

N
3. Klicka pa

& send to Calculators Ll

FILE NAME: NAME ON CALCULATOR: LOCATION: I

Capture 2 Image1 v \/

Screen captures and converted image files will be sent as Pic Vars to black and
white calculators

DESTINATION CALCULATORS: ] Graph Area Only

(®) All Connected Calculators () select Calculators

[J Replace existing content with the same name on destination calculators

CANCEL m

FILE NAME (Filnamn): Detta kan skilja sig fran NAME ON CALCULATOR beroende pa
vilket namn du har gett skarmbilden pa din dator.

NAME ON CALCULATOR (Radknarens namn): Valj bakgrundsbilden (detta bor vara
standardbilden, men du kan &ndra bakgrundsbildens namn pa denna meny).

Anmiérkning: Skarmbilder och konverterade bildfiler skickas som Pic Vars till i
graskala raknare.

GRAPH AREA ONLY (Endast grafomrade): | den hogra panelen, valj huruvida du
endast vill skicka grafomradet eller hela skarmen. Nar du skickar en skarmbild
tillbaka till en raknare ar det bast att endast skicka grafomradet.

Beskara en bild

Anvidnda arbetsomradet Screen Capture (InfGnga skdrmbild) 9



En skdrmbild av grafomradet innehaller helskdarmsbilden av TI-84 Plus CE,
statusfaltet, graframen och grafomradet.

Med Tl Connect™ CE-programvaran kan du beskara bilden till en Graph Area Only-
storlek for att skapa en Background Image Var. Du kan beskdra en skdarm till Graph
Area Only i dialogrutan Send to Calculators (Skicka till rdknare).

W77

LT

.| Graph Area Only

e DESTINATION CALCULATORS (Mottagande raknare): Valj huruvida du vill skicka
bilden till alla anslutna réknare eller till endast valda rdaknare (fran en checklista).

Skicka filer till flera raknare

1. Valj knappen Select Calculators (Valj raknare) i dialogrutan.
2. Markera rutorna intill de raknare som du vill vélja.

3. Klicka pa Send (Skicka).

Dra och sldppa infangade skéirmar till datorapplikationer

Fran arbetsomradet Screen Capture (Infanga skdrmbild) kan du dra och sldppa
infangade skarmar till manga datorapplikationer. Med denna funktion kan du anvanda
raknarskarmar i dina dokument.

Dra och slappa skdrmar i datorapplikationer
1. Oppna eller infdnga skirmen.

2. Dra och sldapp skarmen till ett 6ppet dokument eller en datorprogramapplikation.

Obs: Du kan ocksa anvanda Redigera> Kopiera> Klistra in i ett 6ppet dokument eller
presentator datorprogrammet .

10 Anvinda arbetsomrddet Screen Capture (Infanga skdrmbild)



Anvinda arbetsomradet Calculator Explorer

(Raknarutforskare)

Fran arbetsomradet Calculator Explorer kan du hantera rdaknarens innehall.

& TI Connect™ CE

File

Edit  View  Actions

K—

CONNECTED CALCULATORS (1)

% TI-84 Plus CE - ADAD

Help

@

TI-84 Plus CE

IZZIZIHREEO0B608

niz

AME
SciTools
Prob Sim
PlySmit2
Cabrijr
Celsheet
EasyData
INNODISC
QUADTHEQ
THEKICK

L=

L

-

Archive: 1,807 kB available

e
Flash Application
Flash Application
Flash Application
Flash Application
Flash Application
Flash Application
Program

program
Protected Program
Real List

Real List

Real List

Real List

Real List

Real List

Real Number

Bl Mnmbar

RAM: 140 kB available

-

size

sake

T1kB

88kB

102 kB

123 kB

167 kB

0478

11kB
28
28
28
28

28

98

ap

LocaTIoN

Archive

Archive

Archive

Archive

Archive

Archive

RAM

Archive

- 10| x|

Anvinda arbetsomradet Calculator Explorer (Réknarutforskare)
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Delar av Calculator Explorer (Réknarutforskare) Huvud arbetsyta

Menyrad - Anvand dessa menyer for att hantera filer och bilder, visa raknarinformation
och for att fa hjalp.

File Edit View Actions Help

Anmirkning: Du kan utfora de flesta atgarder pa dessa menyer genom att dra och
slappa poster fran Innehallspanelen.

Verktygsfilt - Klicka pa dessa ikoner for att lagga till, dverfora eller ta bort filer fran din
raknare.

pam| c
0066 0 6

o Lagg till innehall fran din dator.
9 Skicka valt innehall till din dator.

@ Skicka valt innehall till en annan ansluten riknare.
e Ta bort den valda filen.

@ Uppdatera vyn av en ansluten rdknares innehall.

Innehallspanel - Valj filer som du vill hantera fran denna panel.

12 Anvinda arbetsomrddet Calculator Explorer (Rdknarutforskare)



il

File  Edit View  Actions  Help
pint c

[6j  CONNECTED CALCULATORS() TL84Plus CE  Archive: 1,807 kB available | RAM: 140 kB available

5| % R . NAME TveE * sze LocaTion
@ sdTools Flash Application 54kB Archive

== @ probsim Flash Application 71kB Archive
@ eysmiz Flash Application 88kB Archive
@ Cabrir Flash Application 102kB Archive
[ celsheet Flash Application 123kB Archive
[ EasyData Flash Application 167 kB Archive
o INNODISC Program 2478 RAM
Th QUADTHEO  Program 2k Archive
o THEKICK Protected Program 1kB RAM
¢} L Real List 28 RAM
¢} Real List 28 RAM
{1 u Real List 2B RAM
¢} L Real List 28 RAM
{} L Real List 2B RAM
}u Real List 298 RAM
012 v Real Number o8 RAM
012 Boal Mumbar op sam

Vilja en ansluten riknare

Med Tl Connect™ CE-programvaran kan du ansluta flera raknare samtidigt. Klicka pa
den réknare som du vill arbeta med for att vélja den. Den valda raknaren blir
standardraknare for alla atgarder i TI Connect™ CE-programvaran.

Innan du borjar

Anslut raknaren till datorn och se till att den visas i Raknarens lista Panelen.

Kopiera riknarfiler till datorn

Du kan kopiera de flesta data, filer och program fran din rdknare till din dator som en
"innehalls-backup", for att skicka denna till andra réknare eller for att frigéra minne i
raknaren.

Kopiera en fil fran rdknaren till datorn

1. Klicka pa filnamnet for att vélja det.

2. Dra och sldpp filen i en mapp i din dator eller pa ditt skrivbord.
For att kopiera en fil fran rdknaren till datorn som ett innehall backup
1. Vilj Redigera

2. Valjalla

3. Dra och slapp filen i en mapp pa datorn eller pa skrivbordet.

Obs: Det finns ingen automatisk backup funktion har.

Varning: Koppla inte loss kabeln under en 6verforing.

Anvinda arbetsomrddet Calculator Explorer (RGknarutforskare) 13



Kopiera en fil fran datorn till riknaren
1. Navigera till 6nskad fil i din dator.

2. Dra filen till Raknarlistpanelen och hall den 6ver 6nskad raknare.
+ Copy

4, Vilj ett filnamn pa rullgardinsmenyn. Detta blir filens namn i din raknare.
5. Klicka pa Send (Skicka).

3. Slapp musknappen nar du ser

Skicka filer till anslutna riknare

Du kan skicka filer till raknare som &r anslutna till TI Connect™ CE-programvaran.

|Varning: Koppla inte loss kabeln under en 6verforing.

Skicka filer till anslutna raknare

1. Klicka pa filen (s) i innehallspanelen for att vélja den.

"]
2. Klicka pa .

& send to Calculators x|

DESTINATION CALCULATORS:

(O) All Connected Calculators (®) select Calculators

[V] TI-84 Plus CE-1927

[V] TI-84 Plus CE-1BSE

|:| Replace existing content with the same name on destination calculators

CANCEL SEND

e DESTINATION CALCULATORS (Mottagande raknare): Valj huruvida du vill skicka filen
till alla anslutna raknare eller till endast valda réaknare (fran en checklista).

Skicka filer till valda raknare

1. Vilj knappen Select Calculators (Valj raknare) i dialogrutan.
2. Markera rutorna intill de raknare som du vill valja.

3. Klicka pa Send (Skicka).
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Konvertera och skicka bakgrundsbilder

TI-84 Plus CE kan visa bakgrundsbilder och Pic Vars. Dessa variabler visas i
grafomradet.

Anmirkning: All information om bakgrundsbilder galler ocksa TI-84 Plus C Silver Edition
och TI-83 Premium CE.

Arbeta med bakgrundsbilder

Tl Connect™ CE-programvaran konverterar automatiskt en bild du skickar till en
ansluten rdknare till en Background Image Var. Din bild kan visas pa ett annat satt an
du forvantar dig pa grund av konverteringen till pixeldimensionerna 83 x 133.

Anmirkning: For basta resultat, redigera din bild sa att den ar proportionell med 83
x 133 pixlar fore konvertering till 83 x 133 pixlar.

Tips! Forsok att konvertera din bild sa som beskrivs nedan. Om konverteringen inte
blir som du tankt dig kan du skala bilden liknande grafomradet dar Background
Image Vars visas pa CE-raknaren.

e Taen skdrmbild av grafskarmen vid 100 % skalning med arbetsytan for
Skarminfangning. Den har skdarmbilden kan vara i antingen fullt lage eller graf-
tabell-lage. Du kommer att anvanda detta till att skala din bild till en mindre
storlek for att passa storleken pa grafomradet.

e Anvand ditt favoritprogram for presentationer och visa bade skarmbilden och
din bild.

e Dra (storleksférandra) din bild till en mindre storlek och till grafomradets
proportioner.

e Anvand ett beskarningverktyg for att beskara till en ny och mindre bild. Spara
den bilden pa din dator.

e Anvand den har mindre, proportionerliga bilden och konvertera till Image Var
genom att folja de féljande nedan.

Kom ihag! Bevara originalet av din bildfil genom att anvanda ett annat filnamn pa
den mindre bilden pa din dator.

Konverteringen till Background Image Var anvander 16-bitars farg.

Du kan ocksa ladda upp en Background Image Var till emulatorvyn i TI-84 Plus CE i TI-
SmartView™ CE-programvaran.

Hos TI-84 Plus CE visas en Background Image Var som bakgrund endast i grafomradet.
En bakgrundsbild visas som skalad for MODE-skarminstallningarna Full, Horisontell och
Graf-Tabell. Detta bevarar eventuell matematisk modellering som utforts pa en
bakgrundsbild. Du kan inte redigera en bakgrundsbild medan du arbetar med

TI-84 Plus CE. Bakgrundsbilder kors fran och lagras i Arkivminnet.
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Skicka en bakgrundsbild till en ansluten riknare
Du kan skicka en bakgrundsbild och visa den i grafomradet hos TI-84 Plus CE.

Obs: All information om bakgrundsbilder galler daven for TI-84 Plus CE-T, TI-84 Plus C
Silver Edition och TI-83 Premium CE.

NORMAL FLOAT AUTO REAL RADIAN HP l]

Oppna Tl Connect™ CE-programvaran.

Vilj arbetsomradet Calculator Explorer (Utforska raknare).
Anslut TI-84 Plus CE till datorn med kabeln.

Satt pa TI-84 Plus CE.

Vilj den bild som du vill konvertera.

Dra bilden till Raknarlistpanelen och hall den 6ver 6nskad raknare.

Slapp musknappen nar du ser & Copy |

® N O Uk W DNPR

Vilj ett bildnamn pa rullgardinsmenyn (Image0O - Image9). Detta ar bildens namn
hos TI-84 Plus CE.

Anmdrkning: Bildnamnet du viljer blir bildnamnet hos din rdknare. Notera detta
bildnamn (eller gor det till en del av filnamnet i din dator) for identifiering nar du
vill skicka eller dela denna fil.

VARNING: Férladdade bilder lagras i Imagel - Image5. Anvdnd andra Image-
nummer for att undvika 6verskrivning av de forladdade bilderna.

9. Klicka pa Send (Skicka).

Obs: Andra namnet pa datorfilen s& att du kan identifiera din Image Var senare (bro,
fontan, etc.). Raknarens interna Image#-variabelnamn andras inte.

Obs: For att spara bakgrundsbilden till din dator, dra bilden fran Calculator Explorer
(Utforska raknare) till ditt skrivbord eller till mappen dar du vill spara den.

e For att visa din nya bakgrundsbild i grafomradet hos TI-84 Plus CE, tryck pa
[format], &ndra instéllningen av Background (Bakgrund) till bilden som du precis har
skickat till raknaren (till exempel Image5) och tryck pa [graph].

Anmirkning: Fran raknarens grafskdrm kan du ocksa dandra Bakgrunden med det
interaktiva kommandot [draw], BACKGROUND, 1:BackgroundOn.
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Dataimport

Med funktionen Dataimport kan du konvertera/skicka kalkylprogramsdata sparade som
csv-datafiler till rdknaren som réknarlistor eller matrisfiler.

Du kan ta fram funktionen Dataimport fran arbetsomradet Calculator Explorer
(Raknarutforskare).

Viktiga funktioner:
e Skapa (eller ladda ned) ett kalkylark med data.

e Fore import, redigera data i din kalkylprogramvara for att endast tillata numeriska
raknarformat (specificeras nedan) for import till en réaknarfil.

Om kalkylprogrammet

* Endast ett kalkylprogram sparat som en CSV-fil (Comma Delimited) (*.csv) kommer
att importeras at gangen via arbetsomradet Calculator Explorer.

® En kalkylprogramfil (csv) kan dras till Calculator Explorer eller importeras via
menyn Actions > Import Data (.csv) to Lists/Matrix....

e Upp till 6 raknarlistor eller 1 matris fran kalkylprogramsdata kommer att skickas till
den anslutna raknaren.

Regler for att forbereda kalkylprogrammet for import:

¢ Alla celler maste innehalla Reella Tal-data som de upplevs pa raknaren och ingen
text.

- Komplexa tal stéds inte for dataimport.
e Data maste starta i cell Al

e Listimport: Om raknarlistor 6nskas:

& Import your Data x|

Prior to importing your spreadsheet saved in csv file format, make sure
your data starts in cell A1, contains only Real numeric values, and does
not contain text.

Select calculator file type for conversion:

FILENAME: temp_data.csv

COLUMNS:

CANCEL CONTINUE
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- endast sex kalkylprogramskolumner, A-F, kommer att importeras
- Kolumner kan ha en langd pa upp till 999 celler.

- Den forsta tomma cellen i en kolumn tolkas som slutet pa data for den
listimporten

e Matrisimport: om réaknarmatris onskas:

2 Import your Data x|

Prior to importing your spreadshest saved in csv file format, make sure
your data starts in cell A1, contains only Real numeric values, and does
not contain text.

Select calculator file type for conversion:

FILENAME: temp_data.csv

ROW: CoL: CELLS:

CANCEL CONTINUE

- Endast en matris kan importeras fran en kalkylprogramsfil.

- Upp till 400 celler kan importeras. (Exempel: rad x kol: 10 x 5 = 50 celler fran
radomrade 1-10, kolumner A-E.)

- Matrisens dimension i formen (rad x kolumn) kommer att begéras under
importforloppet i Calculator Explorer.

- Entom cell inom den specificerade matrisdimensionen kommer att tolkas som
0.

* Ha inte data i kalkylprogrammet utanfor de tillatna storlekarna for listor eller
matriser enligt ovanstaende beskrivning. Annars blir filen ogiltig nar du férsoker
med en dataimport till Calculator Explorer.

Spara raknarlistor eller matrisfiler

e For att spara skapade raknarfiler till datorn, efter import/sandning till raknare, dra
list- eller matrisfilen fran Calculator Explorer till 6nskad datorplats.

Ta bort riknarfiler
Du kan ta bort data, filer och program fran din réknare.

Ta bort filer fran raknaren

1. Klicka pa filen pa panelen Innehall du vill radera.
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2. Tryck pa .

Avsluta ldiget Exam instdllning pd anslutna CE réknemaskiner

Avsluta instéllningen for providge pa din CE-réknare genom att ansluta CE-raknare till
datorn och vélja

o Atgirder > Avsluta Undersékning-ige pa anslutna CE riknemaskiner i TI Connect™
CE.

Kom ihdg: Anvdnd senaste CE Bundle pa education.ti.com/84ceupdate for att garantera
att din CE rdknare har de senaste och bast ldmpade raknarfilerna for din TI-84 Plus CE.
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Anvanda arbetsomradet Program Editor (Programeditor)

| arbetsomradet Program Editor (Programeditor) kan du arbeta med Tl grundldaggande
program.

& TI Connect™ CE

I [=1k]
Edit  View  Actions  Help

+ =

New Program

_I_

Open Program

-
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Omrdden i arbetsomrdadet Program Editor (Programeditor)

e _ ol x|

File  Edit  View

+ =

[ 9 New Program

_|_

Open Program

o

o Menyrad - Anvand dessa menyer for att hantera filer och program, och for att
fa hjalp.

File Edit Wiew Actions Help

OBS: | arbetsomradet Programeditor kan du bara dra och sldppa program
till innehallspanelen.

9 Verktygsfalt - Klicka pa dessa ikoner fér att Skapa nytt program, Oppna
program, Spara program till dator, Skicka program till ansluten/anslutna
riknare, Angra eller Gér om och Skjutreglaget fér teckenstorlek.

+ @B 8 ©c e A
06 0O (5] (6]

Skapa nytt program.

Oppna program.

Spara program till dator.

[~ o T

Skicka ett program till ansluten/anslutna réknare.
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©® Angraeller Gér om.

® Skjutreglage for teckenstorlek for att 6ka eller minska storleken pa
texten i:

e Katalogpanel
e Programeditor

@ Innehallspanel - Anvind denna panel for att skapa, visa och redigera program.

New Program

_|_

Open Program

-

Katalogpanel - Anvand denna panel for att valja din typ av raknare och vilj
sedan fran katalogtradet (efter kategori) for att skapa program.
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*» Angle

» Catalog

* Char

* Distribution
* Draw

* Finance

* Format
*List

* Math

* Matrix

» Memory

» Mode

* Program

» Statistics
+ Stat Plots
* Table Setup
* Test

* Variables

» Zoom

Syntaxreferenspanel - Anvand denna panel for att visa korrekt syntax for varje
kommando tillsammans med obligatoriska och valfria argument.

x Reference

onp (prgmASM1, pr

Skapa ett nytt program

Nar inga program dr ppna visar Innehallspanelen endast ikonerna Nytt program och
Oppna program.

For att skapa ett nytt program

New Program

» Klicka pa ikonen New Program (Nytt
program). +
Oppna ett befintligt program open rogram

1. Klicka p& ikonen Open Program (Oppna .ﬂ
program). -

2. Navigera till 6nskad mapp.

Anvinda arbetsomrddet Program Editor (Programeditor)
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3. Klicka p3 Open (Oppna).
Redigera ett Var Name

Nya programnamn ar PROG##. Numren anges i ordningsfoljd, till exempel: PROGO1,
PROGO2.

Andra ett programnamn

» Klicka inuti rutan Var Name och skriv in ett nytt namn pa upp till 8 bokstaver eller
siffror (forsta tecknet far inte vara en siffra).

VAR NAME:  PROGO1

Skydda ditt program

Med Tl Connect™ CE-programvaran kan du férhindra att ditt program redigeras efter
att programmet har skickats till en ansluten raknare.

For att skydda ditt program

> Klicka pa kryssrutan intill 1asikonen. s
Spara ett program i din dator
Asterisken i borjan av ett programnamn indikerar att programmet inte har sparats.

For att spara ett program

1. Klicka pa .

2. Navigera till 6nskad mapp.
3. Klicka pa Save (Spara).
Stinga ett program

For att stanga ett program

> Klicka pa x:et vid programnamnet.
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Anviéinda Katalogpanelen

Katalogpanelen innehaller en lista 6ver raknarkommandon, funktioner, variabler och

symboler som du kan anvdnda for att skapa program.

Maximera eller minimera en katalogniva

>

Klicka pa triangeln vid sidan av varje inmatning i Katalogen.

TI-84 Plus CE

» Keypad
» Angle
» Catalog
» Char
» Distribution
» Draw
» Finance
» Format
b List
¥ Math
» Math
» Numeric
» Complex
» Probability
¥ Fraction
I
PEOD
pnid4rUnid
» Matrix
» Menory
» Mode
» Program
» Statistics
» Stat Plots
» Table Setup
» Test
» Variables
» Zoom

Syntax Reference

No reference available

) SR -

VAR NAME:

PROGO7

Placera en kataloginmatning i Innehallspanelen

>

Dra och slapp kataloginmatningen i Innehallspanelen. Detta placerar markoren i

programeditorns kommandorad efter att posten slapps.

- ELLER -

>

Dubbelklicka pa kataloginmatningen. Detta klistrar in posten i programeditorn och
fokus forblir pa Katalogpanelen for att markera dnnu en post. Klicka tillbaka i slutet
av kommandoraden for att fortsatta skriva i editorn.

Anvinda arbetsomrddet Program Editor (Programeditor)
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Sa har undviker du syntaxfel

Anvand katalogen éver kommandon och symboler for att klistra till editorn. Da undviker
du syntaxfel pa grund av felaktig anvandning av versaler och gemener i kommandon.

Exempel:
Skrev du Eval (eller eval(?

Skrev du sin (eller Sin(?

Katalogtradslistan
klistrar in korrekt WA b “Untitled18xp X

versal/gemen- och S

mellanrumsformatterin DispTable VAR NAME | PROGO1
g. »OMS

Dot-Thick

Dot-Thin l
DrawF

eval{

DrawLlnv
Ds<(

e

e

E

PEFF(
Else
End

Eng
EqurString(
ExecLib
expr(
ExpReg
ExprOff
ExprOn
Fedf(

Syntax Reference

Syntaxfel med extra mellanslag
Kéra ett program pd en réiknare

Extra mellanrum kan orsaka syntaxfel nar ett program kors pa raknaren.
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Var finns de extra mellanrummen?

VAR NAME:

Du kan se de extra mellanrummen i
ditt program med hjalp av TI Connect™
CE Program Editor genom att markera
hela programmet. Extra mellanrum i
slutet av kommandorader ska tas bort
innan du skickar programmet till
raknaren.

Om det finns extra mellanrum nar programmet kors i rdknaren ska du vélja Goto fran
syntaxfelskdrmen. Da hamnar markdren pa den programrad dar felet férekommer.
Kontrollera raden for korrekt syntax och extra mellanrum i slutet av kommandoraden.

ERROR: SYNTAX
1:Quit
PHGoto

tX>dim(L1)
:X+dim(Lz)
tFill{(B,L1)
tFill(A.,Lz2)
:Rerpeat KE45

Cursor lands on error./

e Flytta markoren till slutet av den kommandoraden.

e Ta forsiktigt bort extra mellanrum.

OBS: Det finns inget angra pa raknaren.

SNAKE

VARNAME:  SNAKE

ClrHome
1344
548

344D
Xadin (L1)
Xadin (Lz)

Fill(A,L2)
Repeat K,45
0 PT.L2(P)," ")

Output(B,A,"2")

BsL1 (P)

A+Lz (P)

P+1-X(P=X)+P

getKeysK

If max(K={24,25,26,34})
KO

A+(D=28) - (D=24)+A
B+(D=3d)- (D=25)8
A+26( (A=B) - (A=27) )-A
B+108( (B=@)- (B=11))+B
End

Anvinda arbetsomrddet Program Editor (Programeditor)

27



WORFAL FLOAT AUTO REAL EADIAN HF n

:C1lrHome

:12+A

1528

1104

114

13440
) |:Xdim(Lall

i¥rdimilz)

tFil11(B.L1) tF111(B.L1)

Nar blir kommandona raknarkommandon (token)?

Kommandona blir inte raknarkommandon (token) férran programmet skickas till
raknaren.

Om det ar ett fel nar ditt program skickas till eller kors pa raknaren, kontrollera om
varje kommando i raknarprogrammets redigeringsldge verkligen ar ett kommando-
token.

Hur vet man?

Nar ett kommando ar ett token pa raknaren dar markoren pa det forsta tecknet och
hoppar sedan éver kommandot som ett token. Om markoren flyttas bokstav for bokstav
genom ett kommando konverteras inte det kommandot. Ta bort och klistra in
kommandot fran raknaren.

. PROGRAM: B PROGRAM: B On the calculator, the cursor
) :EnvBinom( :invBinom(H

jumps over the “token.”

It only understands the
characters as a function or

command name.

Kom ihdg: Nar du matar in ett program direkt i raknaren klistras kommandot eller
funktionen in fullstdndigt som ett token.

Varning: Vissa raknarkommandon, sdsom LEFT, CENTER, RIGHT och FRAC, ar ord som du
kan anvdnda i en strang. Om ett ord som du anvander i en strang ar samma som ett
raknarkommando kommer ditt ord att bli ett raknar-token och kan ge fel i ditt program.
Undvik att anvdnda ord eller delar av ord som ar samma som TI-Basic-kommandon. Da
undviker du att oavsiktligt gora ett kommando till ett token.

Varning: Sprakinstéllningen i TI Connect™ CE bestammer hur texten tolkas som ett
kommando-token for raknaren. Oppning av program och sandning tillbaka till réaknaren
med Tl Connect™ CE pa olika sprak kan resultera i:

e oo6nskade kommando-token och/eller
e syntaxfel

Anvéinda Syntaxreferenspanelen

Syntax Reference Panel visar syntaxen for varje inmatning i Katalogen, inklusive
obligatoriska och valfria argument.
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Reference

Pt-Change(x,y[ .color#])

HUB- meny for TI-Innovator™ och TI-Innovator™ Rover

Programredigeraren stéder HUB-menyn for TI-Innovator™ for Tl-Innovator™ och TI-
Innovator™ Rover-kommandon. HUB-menyn finns i programmenyn i katalogtradet.
Detta HUB-menytillagg till programredigeraren for TI Connect™ CE ger samma HUB-
menyupplevelse som nar Appen Hub ldses in pa CE-raknaren. Se till att alltid anvdnda
de senaste versionerna av CE OS och appen CE Hub.

Obs! Uppdatera din CE-rdknare med TI84CE Bundle version 5.4.0 pa
education.ti.com/84ceupdate.

Uppdateringen innehaller appen Hub App version 5.4.0. Tl Connect™ CE version 4.0
Program Editor innehaller inte Hub App version 5.4.0-uppdateringen den har gangen.
Nagra poster i Hub App version 5.4.0 kanske inte visas i menyerna pa Tl Connect™ CE
version 5.4.0 men de kan skrivas in for att anvandas.

Se dven:
Anvénda Katalogpanelen ¥ Program
¢ Contral
Skicka ett program till en » Input/Output
réknare O Teiae
* HUB
* Send("SET

¥ Send( "READ
k Settings
Wait
Get |

eval |

Rover [RV)...

® Sond( "CONNECT-Output

* Send| "CONNECT-Input

» Ports

» Send| "RANGE

» Send( "AVERAGE

» Send| "DISCOMNMECT -Output
» Send| "DISCOMNECT-Input
» Hanage

Skicka ett program till en riknare

Du kan skicka ett program till en ansluten raknare.
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For att skicka ett program till en ansluten raknare

1. Spara programmet om du inte redan har gjort detta.

2. Klicka pa .

® FILE NAME (Filnamn): Detta kan skilja sig fran NAME ON CALCULATOR beroende pa
vilket namn du har gett programmet pa din dator.

e NAME ON CALCULATOR (Rdknarens namn): Valj programnamnet (detta bor vara
standardprogrammet, men du kan dndra programmets namn genom att klicka pa
Custom (Anpassat)).

_lalx
B send v CRGRE =I5IxI® £ Name on Calculator = e
Fue e At o1 CALCULATOR: Locarion:
Unttiedt oxp PRoCo1 - Ram v
ustom
OESTIRATION CALCILAYORS: Custom Program names can be up to 8 characters in length
Al Connected Calculators ® select Calculators The first character can be A-Z or 8,

The remaining characters can be A-Z, 6 or0-9
W TI-84 Plus CE-ADAD

] Replace existing content with the same name on destination calculators

| CANCEL
! cnce  sewp

e LOCATION (Plats): Valj huruvida du vill spara programmet i rédknarens RAM eller
Archive (Arkiv).

e DESTINATION CALCULATORS (Mottagande raknare): Valj huruvida du vill skicka
programmet till alla anslutna rdknare eller till endast valda raknare (fran en
checklista).

Skicka program till flera rdknare

1. Valj knappen Select Calculators (Valj raknare) i dialogrutan.
2. Markera rutorna intill de raknare som du vill vélja.

3. Klicka pa Send (Skicka).

Sprakinstéllningar

Om du vill utveckla ett TI-Basic-program i ett annat sprak @n sprakinstallningen i din
dators OS kan du starta om Tl Connect™ CE i ett annat sprak.

1. Vailj File > Change Language.

2. Valj sprakdandring efter att applikationen har startats om.
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=2 Choose a language | = x|

Language changes will take effect after application restart.

English (US) hd

QUIT LATER QUIT NOW CANCEL

QUIT LATER (Avsluta senare) - Behaller det valda spraket och Tl Connect™ CE
startar med detta sprak nasta gang Tl Connect™ CE startas.

QUIT NOW (Avsluta nu) - Sténger lapp. Tl Connect ™ CE kommer att lanseras i
detta valda spraket ndsta gang Tl Connect ™ CE lanseras.

CANCEL (Avbryt) - Ingen sprakdndring. Datorns OS-sprak blir standardinstallning.
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Underhalla din raknare

Uppdatera réiknarens operativsystem

Med Tl Connect™ CE-programvaran kan du ladda ned operativsystem for grafraknare.
Innan du borjar

e Séakerhetskopiera dina raknarfiler (RAM, Archive och Apps).

e Se till att din rdknare ar paslagen och ordentligt ansluten till datorn.

e Om du har flera rdknare i samband med USB-kablar dator, kan OS 6verforingar ske
till specifika raknare.

Detta kan goras genom att valja specifika raknare i dialogrutan Send.

Varning: Koppla inte loss kabeln under en 6verforing.

Uppdatera operativsystem hos grafraknare
1. Klicka pa Actions > Send OS (Atgirder > Skicka OS).
2. Navigera till korrekt OS-fil for din raknarmodell som &r lagrad i datorn.
3. Klicka p& Open (Oppna).

Dialogrutan Skicka OS Oppnas.

x|

OS5 File:

TI-84_Plus_CE-OS-version.Beu

WARNING: Sending the OS will clear the memory on the destination calculators,
but archived items (apps. background images, etc.) will not be erased. Do you want
to send the OS5 now?

DESTINATION CALCULATORS:

() All Connected Calculators (o) Select Calculators

[¥/] T1-84 Plus CE-ADAD
[¥] Tre4 plus CE-1927

[¥] TI-84 Plus CE-1BSE

[] Replace existing content with the same name on destination calculators

CANCEL SEND

4. Vilj fran Destination Riknare:
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DESTINATION CALCULATORS:

() All Connected Calculators (») Select Calculators

[¥] TI-84 Plus CE-ADAD
[¥] TI-84 Plus CE-1BSE

[¥] TI-84 Plus CE-1927

5. Tryck pa Skicka e

Tl CE-paketfil — anvéiind en datofrfil for att uppdatera din CE-
riknare!
Uppdatera din(a) anslutna CE-raknare med ett steg med hjalp av Tl Connect™ CE och

nya Tl CE-paketet hamtat fran education.ti.com/84ceupdate. Ladda alltid ner det
senaste Tl CE-paketet fran education.ti.com/84ceupdate.

Anslut din(a) CE-rdknare till TI Connect™ CE. Dra det lampliga Tl CE-paketet till
Calculator Explorer.

e TI-84 Plus CE/CE-T: TIS4CEBundle-x.x.x.xxxx.b84

Tl Connect™ CE uppdaterar din CE OS, alla CE-appar som behover uppdateras eller
saknas fran din raknare samt ldser in de 5 férladdade Image Vars till Imagel — Image5.
Denna process kan inte stoppas sa se till att spara (dra av) alla dina favoritraknarfiler
med hjalp av Tl Connect™ CE Calculator Explorer. Du kan dra dina favoritraknarfiler
tillbaka till raknaren nar processen for det nya Tl CE-paketet ar slutford.

Dra CE-paketet till Calculator Explorer. Vanta tills hela processen avslutas. Dra inte ur
kabeln under nagon filéverforing. Forvanta dig att CE-raknaren startar om innan
overforingen av Image Var och appar. Forvanta dig att CE-raknaren defragmenterar
(omorganiserar minnet) nagon gang under processen. Meddelanden visas pa Tl
Connect CE-fonstret nar overféringen startar.

Obs: Forvaxla inte Tl CE-paketfilen med CE OS och fil for CE-appar, som fortfarande gar
att laddas ner separat fran education.ti.com. Tl CE-paketet innehaller alla de senaste
filerna som du behdver for att uppdatera och aterstélla din(a) CE-réknare, precis som
om du precis kdpt den/dem, och erbjuder ett snabbt s&tt att uppdatera klassinstéllda
CE-raknare.

Viktigt: Om det star "Waiting... (Védntar...)" pa CE-raknarskdarmen har raknaren férlorat
OS. Detta kan hdnda om en kabel dras ur fran raknaren eller datorn under filverforing.
Ifall den &r ansluten ska du koppla ur de och och sedan ateransluta den till datorn. Dra
CE-paketet till Calculator Explorer.

Kom ihdg: Véanta tills hela processen avslutas. Dra inte ur kabeln under nagon
filoverforing. Forvanta dig att CE-raknaren startar om innan éverféringen av Image Var
och appar. Forvanta dig att CE-raknaren defragmenterar (omorganiserar minnet)
nagon gang under processen. Meddelanden visas pa Tl Connect CE-fonstret nar
overforingen startar.
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Du kan behoéva upprepa denna process och CE-paketet 6verfor filerna igen. Dra inte ur
kabeln under nagon filéverforing.

Se dven:
Uppdatera raknarens operativsystem

Skicka filer till anslutna réknare

Inhdmta ridknarinformation

Tl Connect™ CE-programvaran tillhandahaller information om din raknartyp, produkt-1D,
0S-version, RAM, Arkiv, Sprak, ROM-version och hardvaruversion.

Obs: Calculator Information finns endast fran Calculator Explorer Work Space.
For att visa raknarinformation

> Klicka pa View > Calculator Information (Visa > Raknarinformation).

+4 Calculator Information X

Calculator: TI-34 Plus CE
Product ID:

_____ 0S5 Version:
RAM:

Archive:

Language:

ROM Version:

Hardware Version:

CLOSE

Kompatibilitet med grafréknare
Se TI-84 Plus CE Starthandbok for kompatibilitet med graphing raknemaskiner.

Applikationer, Operativsystem och nagra datafiler med stdds inte numeriska typer inte
delar mellan olika modeller.

TI-Basic-program kan behéva modifieras for att korrekt visning pa hogre upplosning
modeller.
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Allman information
Onlinehjdlp

education.ti.com/eguide

Vilj ditt land for mer produktinformation.

Kontakta TI-support

education.ti.com/ti-cares

Valj ditt land for tekniska- och andra supportresurser.

Service- och garantiinformation

education.ti.com/warranty

Vilj ditt land for information om garantins langd och villkor eller om produkttjansten.

Begrdnsad garanti. Denna garanti paverkar inte dina lagstadgade rattigheter.

Uppdateringar

education.ti.com/84ceupdate

Allmdn information
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